
200-973-0002  September 2002 

 
 

9800 Martel Road 

Lenoir City, TN 37772 

PPXXEE77330000  
High-fidelity Stereo  

In-Flight Entertainment System  
With MP3/Compact Disc Player 

 and Radio Receiver 

 
FAA-STC/PMA Approved 

Document P/N 200-973-0002 
Revision 2 

September 2002 

Installation and Operation Manual 

PS Engineering, Inc. 2002 © 
Copyright Notice 

Any reproduction or retransmittal of this publication, or any portion thereof, without the expressed written permission of PS Engi-
neering, Inc. is strictly prohibited. For further information contact the Publications Manager at PS Engineering, Inc., 9800 Martel 
Road, Lenoir City, TN 37772. Phone (865) 988-9800. 

In certified aircraft, warranty is not valid unless this product is installed by an  
Authorized PS Engineering dealer. 



200-973-0002  September 2002 

Table of Contents 

 SECTION I GENERAL INFORMATION.......................................................................... 1-1 
1.1 INTRODUCTION............................................................................................................. 1-1 
1.2 SCOPE ............................................................................................................................... 1-1 
1.3 EQUIPMENT DESCRIPTION........................................................................................ 1-1 
1.4 APPROVAL BASIS .......................................................................................................... 1-1 
1.5 SPECIFICATIONS........................................................................................................... 1-2 
1.6 EQUIPMENT SUPPLIED................................................................................................ 1-2 
1.7 EQUIPMENT REQUIRED BUT NOT SUPPLIED....................................................... 1-3 
1.8 APPROVED AUDIO SYSTEMS..................................................................................... 1-3 
1.9 LICENSE REQUIREMENTS.......................................................................................... 1-3 
 SECTION II - INSTALLATION.......................................................................................... 2-1 
2.1 GENERAL INFORMATION .......................................................................................... 2-1 
2.1.1 SCOPE ............................................................................................................................. 2-1 
2.2 UNPACKING AND PRELIMINARY INSPECTION.................................................................. 2-1 
2.3 EQUIPMENT INSTALLATION PROCEDURES ...................................................................... 2-1 
2.3.1 COOLING REQUIREMENTS................................................................................................ 2-1 
2.3.2 MOUNTING REQUIREMENTS............................................................................................. 2-1 
2.3.3 MOUNTING RACK INSTALLATION .................................................................................... 2-2 
2.3.4 CONNECTOR ASSEMBLY .................................................................................................. 2-3 
2.4 CABLE HARNESS WIRING.................................................................................................. 2-3 
2.4.1 NOISE ............................................................................................................................... 2-3 
2.4.2 POWER.............................................................................................................................. 2-4 
2.4.3 BACKLIGHTING ................................................................................................................ 2-4 
2.4.4 ANTENNA ......................................................................................................................... 2-4 
2.4.5 UNSWITCHED SUMMED AUDIO ........................................................................................ 2-5 
2.4.6 AUX ENTERTAINMENT AUDIO AND AUX ENABLE.......................................................... 2-5 
2.4.7 SPECIAL PLAYBACK FUNCTION ....................................................................................... 2-5 
2.5 INTERNAL ADJUSTMENTS.................................................................................................. 2-5 
2.6 POST INSTALLATION CHECKOUT ..................................................................................... 2-6 
2.7 UNIT INSTALLATION.......................................................................................................... 2-6 
2.7.1 SYSTEM CHECKOUT ......................................................................................................... 2-6 
2.8 FINAL INSPECTION............................................................................................................. 2-7 
 SECTION III OPERATION................................................................................................. 3-1 
3.1 SCOPE ............................................................................................................................... 3-1 
3.2 OPERATING CONTROLS..................................................................................................... 3-1 
3.2.1 POWER/VOLUME CONTROL (1) ........................................................................................ 3-1 
3.2.2 STOP/EJECT BUTTON (2) .................................................................................................. 3-1 
3.2.3 PLAY/PAUSE BUTTON (3)................................................................................................. 3-1 
3.2.4 THE R/S BUTTON (4) ........................................................................................................ 3-2 
3.2.5 THE DATA KNOB (5) ........................................................................................................ 3-2 
3.2.6 THE MODE BUTTON (6) .................................................................................................. 3-2 
3.3 RADIO PRESET FUNCTION................................................................................................. 3-2 
3.4 PRE-RECORDED FILE PLAYBACK ..................................................................................... 3-3 
3.5 DISPLAY DIMMING (7) ....................................................................................................... 3-3 
 SECTION IV- WARRANTY AND SERVICE.................................................................... 4-1 



PS Engineering 
PXE7300 Series IFE System  

Installation and Operator’s Manual 

200-973-0002 Page ii September 2002 

4.1 WARRANTY ........................................................................................................................ 4-1 
4.2 FACTORY SERVICE ............................................................................................................ 4-1 

 APPENDIX A – MP3 CREATION ....................................................................................A 
5.1 CREATING MP3S FROM AN AUDIO CD................................................................................A 
5.2 CREATING PLAYBACK FILES USING MUSICMATCH ..........................................................A 

 APPENDIX B – INSTALLATION DRAWINGS ...........................................................B 

 APPENDIX C CONNECTOR INTERCONNECT................................................................C 

 APPENDIX D- STC INFORMATION AND INSTRUCTIONS FOR CONTINUING 
AIRWORTHINESS ......................................................................................................................D 
8.1 INSTRUCTIONS FOR FAA FORM 337, PXE7300S ................................................................D 
8.2 INSTRUCTIONS FOR CONTINUING AIRWORTHINESS, PXE7300S.......................................D 
8.3 MASTER DRAWING LIST ......................................................................................................D 
8.4 USE OF APPROVED MODEL LIST .........................................................................................D 
 APPENDIX E RTCA DO160D/EUROCAE ED-14D ENVIRONMENTAL 
QUALIFICATION FORM...........................................................................................................E 
 
 



PS Engineering 
PXE7300 Series IFE System  

Installation and Operator’s Manual 

200-973-0002 Page 1-1 September 2002 

 Section I GENERAL INFORMATION 

1.1 INTRODUCTION  

Quality cockpit and cabin entertainment has long been an elusive dream in general aviation. From marginal 
performance to unapproved parts, pilots couldn’t enjoy the same music in their aircraft as they could in the 
family car.  

The PXE7300-Series represents such a product. This one unit combines a compact disk (CD) player with 
MP3 capability and an AM/FM radio for ultimate in-flight entertainment capability.  

Before installing and/or using this product, please read this manual completely. This will ensure that you 
will take full advantage of all the advanced features in the PXE7300.  

1.2 SCOPE  

This manual provides detailed installation and operation instructions for the PS Engineering PXE7300-
series of IFE Systems. This includes the following units: 

Model Part Number Description 

PXE7300 11970 Integrated IFE System with CD/MP3/AM/FM 

 Option 1  Prerecorded playback 

 Option 2 European Version Tuner 

Where the functions are identical to all units, it will be referred to herein as a PXE7300. Otherwise, the 
applicable units will be specified. 

1.3 EQUIPMENT DESCRIPTION 

The PXE7300 System is a single panel mounted unit that contains a CD player with MP3 media capability 
and an AM/FM radio receiver. It also contains a high-fidelity stereo amplifier to provide the entertainment 
output to the aircraft audio system. 

An 8-digit LED display provides information about the systems modes and media in use.  

1.4 APPROVAL BASIS  

The PXE7300, is FAA approved FAA-STC SA02572AT and manufactured under PMA. PQ1336CE. 

All systems comply with relevant portions of EUROCAE ED-14D/DO-160D (Environmental Conditions 
and Test Procedures for Airborne Equipment), ED12B/DO-178B (Software Considerations for Airborne 
Equipment) and ED- 18/DO-214 (Audio Systems Characteristics and Minimum Operational Performance 
Standards for Aircraft Audio Systems).  

STC SA02572AT can be used as a basis for approval in other aircraft provided the generic installation 
manual, Document Number 200-973-0002 or later approved revision, is followed.  

Advisory Circulars AC43.13-1B Acceptable Methods, Techniques, and Practices - Aircraft Inspection and 
Repair, and 43.13-2A - Acceptable Methods, Techniques, And Practices - Aircraft Alterations are to be 
used to resolve any issues not specifically addressed by the Installation Manual. Instructions for Continu-
ing Airworthiness (ICA) are provided in the supplied data. 

Operation is subject to the following conditions: 
This device may not cause harmful interference. 
This device must accept any interference received, including interference that may cause undesired opera-
tion.  
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1.5 SPECIFICATIONS  
FAA-PMA COMPLIANCE 

APPLICABLE DOCUMENTS: RTCA/DO-214 
RTCA/DO-160D  
RTCA/DO-178B (Level E) 
RTCA DO-254  (Level E) 

ENVIRONMENTAL Qualifications:  B1CABSXXXXXXZBBBAUHXXX 
Temperature Range: 
   Operating: 
   Storage: 

 
-15º C to 55ºC  
-40º C to 85ºC 

Altitude:  Up to 25,000 feet in a non-pressurized area of the cockpit. 
DIMENSIONS:  Height: 2.0 in. (5.1 cm) Width: 6.25 in. (15.9 cm)  

Depth: 7.7 in. (19.8 cm) 
WEIGHT (With Rack & Connectors): 2.6 lb. (1.2 kg) 

POWER REQUIREMENTS (Including Internal Lighting): 
Voltage: 11 to 33 VDC  
Maximum Current:  
11970 

1.5 Amp (Externally protected by a 2 Amp circuit pull-
type breaker.) 

Typical operating current: 
Lighting Current 

800 mA 
5 mA 

Audio Specifications 
Output Impedance: 150 - 1000 Ω 
Audio Output:  38 mW each channel, no clipping <1% THD 
Distortion: <1% THD  
Music Freq. Response, 3 dB: 14 Hz –22 kHz 

FCC Type Acceptance 
Part 15 Verification to Part 15  

Radio Tuning 
North America AM: 530 – 1710 kHz, 10 kHz steps 

FM: 87.7 – 107.9 MHz, 200 kHz steps  
European (Option E) AM: 531 - 1602kHz, 9kHz steps 

FM: 87.5 - 107.9MHz, 100kHz steps 

1.6 EQUIPMENT SUPPLIED  

1 ea. of the following units: 

Model Part Number Description 
PXE7300 11970 IFE System with AM/FM CD MP3 

PXE7300 Installation Kit: 250-973-0001 as shown 

Part Number Description Quantity 
120-425-4402 44 Pin Connector Key 4/5 1 
202-730-00XX Pilots Guide 1 
425-001-0002 Gold Plated Crimp Pins 30 
430-730-0010 Tray  1 
430-730-8025 Tray Shield 1 
475-440-0007   4-40x7/16" Phil-Pan w/Nylon Patch 2 
475-630-0002 6-32 Clip Nut 6 
475-632-0012 6-32” x ½” Fhp Screw 6 
510-730-0001 Passive AM/FM Antenna 1 
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1.7 EQUIPMENT REQUIRED BUT NOT SUPPLIED  
a) Circuit Breaker, PULL TYPE: 1 ea. 2 amp 
b) Aircraft Audio System (See section 1.8 for approved system list) 
c) Interconnect Wiring  

1.8 APPROVED AUDIO SYSTEMS 

This is a list of audio system that the PXE7300 should interface with adequately.  

Approved Audio Systems, PXE7300 

Certified interface is approved only for audio systems that are FAA-TSO approved. 

Make Model Part Number 

PM1000II 11920,11922 

PM3000 11931, 11932 

PMA6000-Series 6000 (all) 

PMA7000-Series 7000 (all) 

PCD7100 11950, 11951 

PMA4000 11942 

PS Engineering 

PAC24 050-240-(all) 

SL10-Series 430-6060-XX UPS Aviation Technologies 

SL15-Series 430-6065-XX 

Bendix/King KMA28 066-01176-0101 

GARMIN International GMA340 010-00152-XX 

While the output of the PXE7300 is designed to work the majority of intercoms and audio panels at the 
time of development, PS Engineering cannot guarantee satisfactory results for all devices. 

1.9 LICENSE REQUIREMENTS 

North America- None 

International Customers may need to check with appropriate governing bodies before using the system. 
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 Section II - Installation 

2.1 GENERAL INFORMATION  

2.1.1 SCOPE  

These sections provide detailed installation and interconnect instructions for the PXE7300 In-Flight En-
tertainment System with integrated Compact Disc (CD) Player and AM/FM radio receiver. 

Please read this manual carefully before beginning any installation to prevent damage and post-installation 
problems. Installation of this equipment requires special tools and knowledge.  

NOTE: 
An appropriately rated Certified Aircraft Repair Station must install  
this equipment in accordance with applicable regulations. PS Engi-
neering, Incorporated warranty is not valid unless the equipment is 

installed by an authorized PS Engineering, Incorporated dealer. Fail-
ure to follow any of the installation instructions, or installation by a 

non-certified individual or agency will  void the warranty, and may re-
sult in an unairworthy installation. 

2.2 Unpacking and Preliminary Inspection 

Use care when unpacking the equipment. Inspect the units and parts supplied for visible signs of shipping 
damage. Examine the unit for loose or broken buttons, bent knobs, etc.  Verify the correct quantity of com-
ponents supplied with the list in Section 1.6 (B). If any claim is to be made, save the shipping material and 
contact the freight carrier. Do NOT return units damaged in shipping to PS Engineering. If the unit or an 
accessory shows any sign of external shipping damage, contact PS Engineering to arrange for a replace-
ment. Under no circumstances attempt to install a damaged unit in an aircraft. Equipment returned to PS 
Engineering for any other reason should be shipped in the original PS Engineering packaging, or other 
UPS approved packaging.  

2.3 Equipment Installation Procedures 

2.3.1 Cooling Requirements 

Forced air-cooling of the PXE7300 is not required. However, the unit should be kept away from heat pro-
ducing sources (i.e. defrost or heater ducts, dropping resistors, heat producing avionics) without adequate 
cooling air provided. 

2.3.2 Mounting Requirements  

The PXE7300 must be rigidly mounted to the instrument panel or other structure of the aircraft structure 
and within view and reach of the persons wishing access. Installation must comply with FAA Advisory 
Circular AC 43.13-2A (or later revision). The unit may be mounted in any area where adequate clearance 
for the unit and associated wiring bundle exist. 

The unit must be installed within ±30° of horizontal along the pitch axis, and ±10° of horizontal along the 
roll axis in level flight. 

Avoid installing the PXE7300 close to high current devices or systems with high-voltage, pulse type out-
puts, such as DME or transponders. 
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2.3.3 Mounting Rack Installation 

Remove the unit from the mounting tray by unscrewing the 3/32" hex-head screw that is near the left edge 
of the unit. Carefully slide the unit free of the tray. Set the unit aside in a safe location until needed.  Install 
the tray using six FHP 6-32 x ½" screws. The unit must be supported at front and rear of the mounting tray. 
See Appendix B. 

 

The tray mounting can be made in any area that exists for adding additional avionics. Instrument panel 
mounting is accomplished in accordance with AC 43.13-2A, Chapter 2. 

Existing Structure (from behind 
panel)

Avionics Mounting Rails

Existing Transponder

Center Avionics Stack

   

Factory Avionics Location
Factory Avionics Mounting Rails

 
Figure 2-2 Avionics Mounting Rails (Typical) 

2.00”

6.31”

Figure 2-1 Typical Tray Installation Location 
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Panel Opening
Saw and 
file used to 
remove 
existing 
instrument 
panel from 
this 
location

 
Figure 2-3 Completed panel opening (Typical) 

2.3.4 Connector Assembly 

The unit connector mates directly with the circuit boards in the PXE7300. The connector (part number 
120-425-4402 is a Molex crimp-type, and requires the use of a Molex hand crimp tool, EDP P/N 11-01-
0203, CR6115B (or equiv.).  The connector is mounted to the unit tray with 2 ea. #4-40 screws, from the 
inside of the tray. Ensure that proper strain relief and chafing precautions are made during wiring and in-
stallation. 

B

A

C

120-425-4402
Connector475-440-0007 (2 plcs)

Screws

Fr
on

t o
f t

ra
y

Rear
of tray

 

2.4 Cable Harness Wiring 

Referring to the appropriate Appendix, assemble a wiring harness as required for the installation. All wires 
must be MIL-SPEC in accordance with current regulations. Two- and three-conductor shielded wire must 
be used where indicated, and be MIL-C-27500 or equivalent specification. Proper stripping, shielding and 
soldering technique must be used at all times. It is imperative that correct wire be used. 

Refer to FAA Advisory Circular 43.13-1B and 2A for more information. Failure to use correct techniques 
may result in improper operation, electrical noise or unit failure. Damage caused by improper installation 
will void the PS Engineering warranty.  PS Engineering can provide a custom made harness, visit www.ps-
engineering.com for more information. 

2.4.1 Noise  

Due to the variety and the high power of radio equipment often found in today's general aviation aircraft, 
there is a potential for both radiated and conducted noise interference.  



PS Engineering 
PXE7300 Series IFE System  

Installation and Operator’s Manual 

200-973-0002 Page 2-4 September 2002 

 

The PXE7300 power supply is specifically designed to reduce conducted electrical noise on the aircraft 
power bus by at least 50dB. Although this is a large amount of attenuation, it may not eliminate all noise, 
particularly if the amplitude of noise is very high. There must be at least 12 VDC present at the connector 
pin 21, of the PXE7300 for the power supply to work in its designed regulation. Otherwise, it cannot ade-
quately attenuate power line noise. Shielding can reduce or prevent radiated noise (i.e., beacon, electric 
gyros, switching power supplies, etc.) However, installation combinations can occur where interference is 
possible.  The PXE7300 was designed in a RFI hardened chassis and has internal Electromagnetic Interfer-
ence (EMI) filters on all inputs and outputs. 

Ground loop noise occurs when there are two or more ground paths for the same signal (i.e., airframe and 
ground return wire). Large cyclic loads such as strobes, inverters, etc., can inject noise signals onto the 
airframe that are detected by the audio system. Follow the wiring diagram very carefully to help ensure a 
minimum of ground loop potential. Use only Mil Spec shielded wires (MIL-C-275000, or better). 

2.4.2 Power 

The PXE7300-Series units are compatible with both 14 and 
28 Volt DC systems. A two (2) Amp PULL-TYPE breaker is 
required. Power and ground wires must be a twisted #18 
AWG pair. Connect airframe power ground to Pin 22 only. 

See Appendix B for typical circuit breaker layout. 

2.4.3 Backlighting 

The PXE7300 has an automatic dimming of the pushbutton 
annunciator LEDs controlled by a photocell. A dimmer control allows the bezel text backlighting to be 
controlled by the aircraft dimmer. Connect the 14 V dimmer control to pin 1, the 28 V dimmer to pin A, as 
required. 

2.4.4 Antenna 

The passive AM/FM antenna, part number 510-730-0001 (included) is optimized for FM radio perform-
ance. Therefore, when used for AM reception, the operator may only receive the most powerful 3 to 5 AM 
stations. In contrast to an ADF, where audio fidelity is not important, the PXE7300 requires higher signal 
levels to ensure fidelity. 

For optimum performance, some installers may desire an external AM/FM antenna. PS Engineering rec-
ommends a Comant CI-222-L, installed in accordance with AC43.13-1A, Chapter 3. 

Another AM performance-enhancing alternative is to connect the PXE7300 antenna input to an unused 
VOR port of the VHF NAV antenna splitter. Do NOT add another splitter.  

The included antenna can be mounted wherever convenient inside the cockpit, as long as it is in a window. 
Verify that the antenna is not an impediment to crew vision outside the cockpit when installed, 

For optimal operation, it should be near the windshield. Clean the mounting surface with appropriate 

Figure 2-4 Circuit breaker location 
(Typical)

Figure 2-5 Antenna Installation 
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means (glass cleaner, etc), and apply adhesive (supplied with antenna). Route the antenna cable along edge 
to the glareshield, and then connect to the PXE7300 connector.  Avoid running the antenna cable near 
high-current carrying wires, such as windshield heat, etc.  

The antenna cable center conductor is connected to Pin 2, braid is connected to pin B.  

2.4.5 Unswitched Summed Audio 

PXE7300 units have four audio inputs that are summed together and presented to the audio output, J1 pin 
18 WRT V. 

NOTE: These can be used to implement additional audio warnings when connected to the appropriate 
Unswitched audio input of an audio panel. This includes Autopilot warnings, TAWS, GPS alerts, Radio 
Altimeter, etc. 

2.4.6 Aux Entertainment Audio and AUX Enable 

Besides the disc and AM/FM, the PXE7300 has the ability to act as a switching control for an additional 
entertainment input (DVD, external XM Radio tuner, etc.).  

The audio input is Pin 16 (R), Pin 17 (L) with respect to Pin K.  

To enable the mode, add an internal jumper on the pins marked J2, or apply a ground to Pin 20 of the rear 
connector. 

2.4.7 Special Playback Function (Option 1 only) 

The PXE7300 can be used to play up to five specially encoded audio tracks. This can be used for passenger 
briefings, tour narration, etc. These files will play automatically when a specific pin is grounded on the init 
connector, activated by a switch or logic input that pulls either to ground or to a positive voltage if the unit 
is configured properly. 

In order to use a positive voltage (>4 VDC), the unit must have jumpers installed at the following loca-
tions: 

Input 1 - R134 
Input 2 - R146 
Input 3 - R155 
Input 4 - R135 
Input 5 - R147 

Recorded MP3 files must be stored on a disc with the volume label 7300. The individual files shall be la-
beled 0001.mp3, 0002.mp3, and so on.  

The file playback is: 
Message Number Unit connector Pin Filename 

1 5 0001.mp3 
2 9 0002.mp3 
3 7 0003.mp3 
4 10 0004.mp3 
5 8 0005.mp3 

See the operation manual for details on creating files and discs. 

 

 

 
2.5 Internal Adjustments 
None 
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2.6 Post Installation Checkout  

After wiring is complete, verify power is ONLY on pin 21 of the connector, and airframe ground on bot-
tom connector pin 22.  Failure to do so will cause serious internal damage and void PS Engineering's war-
ranty. 

2.7 Unit Installation  

To install the PXE7300, gently slide the unit into the mounting rack until the hold-down screw is engaged. 
While applying gentle pressure to the face of the unit, tighten the 3/32" hex-head in the unit until it is se-
cure. DO NOT OVER TIGHTEN.  

Warning :  Do not  over- t ighten the lock down screw while  ins ta l l ing  the uni t  in  t ray.  
Internal damage will result. 

2.7.1 System Checkout 
1. Insert disc, and verify that the player accepts the disk with about ½ of the diameter in the unit. The 

player should pull the disk smoothly and drop into place. 
2. The player will begin to play, automatically about 20 seconds (after reading the disc). 
3. If the unit is in disc mode, with CD inside at power-up, it will play (after reading the disc). 
4. Verify that all Disc modes operate. 
5. Push the “Eject” button and verify that the disc is ejected within about 10 seconds. 
6. Verify radio operation on AM and FM 
7. Verify that aux audio is presented to the output (if connected). 
8. Evaluate the audio interface to be certain that the IFE audio is muted during intercom and radio com-

munication.  
a. If muting override is provided, evaluate the switch location and verify operation. 
b. Evaluate the audio performance 
c. Evaluate the audio level to verify that the music is adequate under flight conditions. 
d. Evaluate the muting system to demonstrate that the music will be adequately muted if de-

sired, by radio and intercom. 
e. Evaluate the muting override control if equipped. 

9. Evaluate failure remediation from crewmember location 
a. Turn unit off 
b. Locate and pull unit circuit breaker 
c. With the disc playing, with minimum volume, listen to the following audio sources (as 

equipped), adjusted to normal listening level: 
i. Comm 1, comm. 2, comm 3, HF 

ii. Nav 1, Nav 2 
iii. ADF (1 and 2) 
iv. DME (1 and 2) 
v. Marker  

vi. Any other audio sources 
10. Select FM Mode, and repeat step 6, listening for interference on the aircraft audio sources. Pay par-

ticular attention to the frequencies listed in table. 
FM COM 

107.3 118.000 
107.5 118.200 
107.7 118.400 
107.9 118.600 

FM/COM Cross Reference 
11. Select AM Mode, and repeat step 6, listening for interference on the aircraft audio sources. 
12. Select COM 1 for transmit. Tune COM 1 to 118.00, and the PXE7300 to 107.3 MHz. Transmit a test 

count and evaluate the unit display and audio output for inconsistencies 
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13. Repeat step 10 for COM 2, and other transmitters. 
a. Tune Nav 1 to local station and perform a standard VOT test in accordance with 14 CFR 91.171.  
b. Note the indicated VOR bearing on both systems. 
c. Turn the PXE7300 on and off, and observe any change in the VOR indication that could be attrib-

uted to the PXE7300. 

2.8 Final Inspection 

Verify that the wiring is bundled away from all controls and no part of the installation interferes with air-
craft control operation. Move all controls through their full range while examining the installation to see 
that no mechanical interference exists. Verify that the cables are secured to the aircraft structure in accor-
dance with good practices, with adequate strain relief. Ensure that there are no kinks or sharp bends in the 
cables and coaxial cables. Verify that the cables are not exposed to any sharp edges or rough surfaces, and 
that all contact points are protected from abrasion. 

Complete logbook entry, FAA Form 337, weight and balance computation and other documentation as 
required. Sample text for FAA Form 337 and instructions for continuing airworthiness can be found in 
Appendix F. 

Return completed warranty registration application to PS Engineering. 
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 Section III OPERATION 
GENERAL INFORMATION 

3.1 SCOPE  

This section describes the operation of the PXE7300 In-Flight Entertainment system. 

Operating controls consist of two rotary knobs with push-push switches, and four buttons.  

 
Figure 3-1 Front Panel Controls 

3.2 Operating Controls 

The single-disk player is designed for simple operation. The Disc player will begin to play automatically 
when a Disc is inserted (unless the disc is specially formatted as 7300 volume, see section 3.4). The disc 
will play through in order, and then stop at the end.  If a disc is not inserted, the unit will be in the  FM 
radio mode. 

NOTE:  
When a disc is inserted, the display will show “Reading . . .” for up to 20 seconds, depending on the media 

and amount of information contained. 

 

3.2.1 Power/Volume Control (1) 

The PXE7300 system is turned on and off by pushing the volume (left hand) knob. The left knob is the 
volume control. Turning the knob clockwise will increase the volume.  

3.2.2 Stop/Eject Button (2) 

The Stop/Eject button will stop the disc. Hold for 3 seconds to eject the disc.  

In AM or FM Radio Mode, this button scans up the frequency band for a strong signal. 

3.2.3 Play/Pause Button (3) 

Pressing the play/pause button momentarily will pause the player. Press for about one second to advance 
the track or select another random track. Press and hold the PLAY/PAUSE to for an INTRO SCAN that 
plays a few seconds of each track before advancing.  

Momentarily pressing STOP/EJECT & PLAY/PAUSE buttons at the same time will cause the track to 
jump backward. 

NOTE: 
The MP3 mechanism in the PXE7300 is more sensitive to scratches on the play side of the disc than tradi-

tional CD players. It is suggested to use CDs that have few to no scratches for optimum performance. 
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In AM or FM Radio Mode, this button scans down the frequency band for a strong signal. 

3.2.4 The R/S Button (4) 

This selects random or sequence play in the disc mode.  

3.2.5 The Data Knob (5) 

In the Disc mode (CD or MP3), the knob will advance (CW) or decrease (CCW) the track. Track number is 
displayed when the knob is in motion. Then it will display the track name and then begin to play. 

In AM or FM radio mode, this knob can be used to tune the radio directly. 

If the playing media is an MP3 format, the pushing the DATA knob will display the data (if stored and 
available) from the playing tracks in sequence when the knob is pushed. 

 Song Name 
 MP3 Actual File Name 
 Album  
 Artist 

Depending on the total size of the information stored on the disc, the available data may be truncated in the 
following manner: Small number of files, Actual File Name, Larger number of files, Truncated File Name, 
Most files, Track Number. 

3.2.6 The MODE Button (6) 

This button cycles through the operating modes, Disc, FM, AM, and AUX (if enabled).  

3.3 Radio Reception 

The passive AM/FM antenna, part number 510-730-0001 (included) is optimized for FM radio perform-
ance. Therefore, when used for AM reception, the operator may only receive the most powerful 3 to 5 AM 
stations. In contrast to an ADF, where audio fidelity is not important, the PXE7300 requires higher signal 
levels to ensure fidelity. 

For optimum performance, some installers may desire an external AM/FM antenna. PS Engineering rec-
ommends a Comant CI-222-L. 

Another alternative is to connect the PXE7300 antenna input to an unused VOR port of the VHF NAV 
antenna splitter. Do NOT add another splitter.  

3.4 Radio Preset Function 

The PXE7300 can save up to nine AM and nine FM frequencies for future recall. Select the desired radio 
frequency. 

To set press the “R/S” button (4). The next available slot will be displayed as “S#.” (# being the available 
memory location). Within five seconds, select the desired frequency using the DATA knob (if not already 
displayed). Press the R/S (4) again to save the selection. The display will flash, indicating a successful 
save. 

You can select the “S” slot by pressing the Stop (up) and play (down) buttons. 

To access the channel, press the DATA knob (5) the radio mode, and select the preset with the DATA 
knob or scan up (2) and down (3) buttons. 
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Action Disc Result Radio Result 

Stop/Eject short press Stop Frequency Scan Up 

Stop/Eject long press Eject (also in AUX) Frequency Scan up 
Play/Pause short press Pause Frequency Scan Down 

Play/Pause Medium 
press (3 sec) 

Select next track/file and keep play-
ing or a random track if in the ran-
dom mode 

Frequency Scan Down 

Play/Pause Long press 
(> 3 sec) 

Intro Scan, Plays first few seconds 
of each song, and advances 

Frequency Scan Down 

MODE press Change to FM, AM, AUX (if en-
abled) 

Change from FM to AM, to 
AUX to (if enabled) to DISC  

R/S press Toggle into Random or normal Se-
quence play 

Enter the preset “Set” mode 

DATA knob CW Select next track and play Increase radio frequency or 
preset channel 

DATA knob CCW Select previous track and keep play-
ing 

Decrease radio frequency or 
preset channel 

DATA knob Push Show data on file (if available) Enter Pre-select Frequency 
Recall Mode 

Table 1- Modes 

3.5 Pre-recorded File Playback (Option 1 ONLY) 

The PXE7300 is designed to play up to five special files on a recorded MP3 disc. This can be used for pas-
senger briefing, tour narration, or other in flight uses. 

When one of the five inputs is triggered, a corresponding file on a specially encoded disc will start to play, 
regardless of the mode in use.  

When the file has completed play, the unit will return to the previous mode and track, but it will be paused.  

The special disc must be labeled as the volume 7300, and the tracks 0001.MP3 through 0005.MP3. Other 
files, such as music, can be stored on this disc. The normal files will play, but files with the filename 
0001.MP3 through 0005.MP3 will not play unless the respective input is activated, OR specifically se-
lected from the front panel. This section can be used to test the disc and determine which files are stored. 

See Appendix A for details on storing MP3 files.  

3.6 Display Dimming (7) 

The display is automatically adjusted for ambient light conditions by a photocell. The backlighting is ad-
justed by the aircraft dimmer circuit. 
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 Section IV- Warranty and Service 

4.1 Warranty 

In order for the factory warranty to be valid, the installations in a certified aircraft must be accomplished by 
an FAA-certified avionics shop and authorized PS Engineering dealer.  If the unit is being installed by a 
non-certified individual in an experimental aircraft, a factory-made harness must be used for the warranty 
to be valid. 

PS Engineering, Inc. warrants this product to be free from defect in material and workmanship for a period 
of one (1) year from the date of installation as recorded in aircraft logbook and/or on FAA Form 337. Dur-
ing the twelve (12) months, PS Engineering, Inc., at its option, will send a replacement unit at our expense 
if the unit should be determined to be defective after consultation with a factory technician. 

All transportation charges for returning the defective units are the responsibility of the purchaser. All do-
mestic transportation charges for returning the exchange or repaired unit to the purchaser will be borne by 
PS Engineering, Inc. The risk of loss or damage to the product is borne by the party making the shipment, 
unless the purchaser requests a specific method of shipment. In this case, the purchaser assumes the risk of 
loss. 

This warranty is not transferable. Any implied warranties expire at the expiration date of this warranty. PS 
Engineering SHALL NOT BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES. This 
warranty does not cover a defect that has resulted from improper handling, storage or preservation, or un-
reasonable use or maintenance as determined by us. This warranty is void if there is any attempt to dissem-
ble this product without factory authorization. This warranty gives you specific legal rights, and you may 
also have other rights, which may vary from state to state. Some states do not allow the exclusion of limita-
tion of incidental or consequential damages, so the above limitation or exclusions may not apply to you.   

All items repaired or replaced under this warranty are warranted for the remainder of the original warranty 
period. PS Engineering, Inc. reserves the rights to make modifications or improvements to the product 
without obligation to perform like modifications or improvements to previously manufactured products. 

4.2 Factory Service 

The unit is covered by a one-year limited warranty. See warranty information. Call PS Engineering, Inc. at 
(865) 988-9800 before you return the unit. This will allow the service technician to provide any other sug-
gestions for identifying the problem and recommend possible solutions.  

After discussing the problem with the technician and you obtain a Return Authorization Number, ship 
product to: 

PS Engineering, Inc. 
Attn: Service Department 
9800 Martel Rd 
Lenoir City, TN 37772 
(865) 988-9800   FAX (865) 988-6619 

Email: support@ps-engineering.com 

NOTE: PS Engineering will not be responsible for any units shipped in the U. S. Mail.  

Units received without either a Return Authorization or a contact telephone number will be refused 
and returned to the sender. 
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 Appendix A – MP3 Creation 
5.1 Creating MP3s from an Audio CD 

1. Start MusicMatch JukeBox.(www.musicmatch.com) Press the recorder button, which is the 
small red dot located in the top right corner. This will open the recorder window located at 
the bottom of the screen. 

2. Insert an audio CD into the CD drive. MusicMatch will automatically read the disc and dis-
play the contents in the recorder window. Press the REFRESH button to check the Internet 
database for CD information, such as artist, song title, or album. If this information is avail-
able, it will automatically be updated in the file. 

3. Select Options->Recorder->Format and select either MP3 or MP3PRO format. You may also 
set the MP3 file quality under the Options->Recorder->Quality menu. 

4. Select the tracks to be copied to MusicMatch by checking the box next to the desired track. 
Press the record button in the lower left corner when complete 

5. MusicMatch will then convert the files from the audio CD to MP3 and display them in the 
Music Library box located in the middle of the screen 

6. To edit the MP3 information, select a file in the Music Library and press the TAG button in 
the top right corner of the Music Library box. This will display the MP3 tagged information 
screen. Select the General tab to show the information that can be modified for the PXE7300. 

7. The PXE7300 can display song name, artist, album, and filename. This corresponds to the 
Track title, Artist, Album, and Track Filename fields shown on the screen. Each of these 
fields can be modified to the user’s preference. Note: The PXE7300 is limited to displaying 
up to 22 characters in each of these fields. Click on the appropriate field to modify the track 
title, artist, or album. To modify the filename, select the Rename Files button in the lower left 
corner. Click on the field labeled New File Name and press OK to change the file name. Press 
the Apply and OK buttons to update the information 

5.2 Creating Playback Files Using MusicMatch (Option 1 units only) 

1. Create up to five MP3 files with the desired playback messages. These files must be named 
0001.MP3 to 0005.MP3. File 0001 corresponds to playback input 1, etc. 

2. Start MusicMatch JukeBox. Click the ADD icon in the Music Library window to bring up the 
file dialogue box. Select the files 0001.MP3 – 0005.MP3 and click the ADD button. This 
will transfer a copy of the files to the Music Library. 

3. Select a file in the Music Library box and click on the TAG button to access the MP3 tagged 
information screen. Select the General tab to show the MP3 file information. Fill in the Track 
Title field. This information will be displayed on the PXE7300 when the file is active. This 
field may be up to 22 characters in length. 

4. Select File->Create CD to open the CD burner window. 
5. Select the MP3 disc icon to burn an MP3 disk. 
6. Double click on the Volume Name box, located to the right of the three disc types. Type 

7300 in the window and press RETURN to update the CD volume name.  
7. Select the ADD icon (+ sign) to open the file dialogue box. Select the files 0001.MP3 – 

0005.MP3 and press the ADD button. Make sure these files are located in the root direc-
tory of the disc. Select any other MP3 files you wish to add to the disc. Note: These files 
must not begin with a “000” prefix or the PXE7300 will play the incorrect tracks! Files 
can also be dragged from the Music Library box.  

8. Place the blank CD in the drive and select the BURN icon to burn the CD. 
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 Appendix B – Installation Drawings 
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Figure 6-1 Panel Location Drawing (Typical) 120-973-8801 
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Figure 6-2 PXE7300 Installation Diagram (Typical) 120-973-2488 
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Figure 6-3 Tray Installation Drawing, 002-973-0430 
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Figure 6-4 Circuit breaker installation drawing 120-973-8802 (typical) 
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 Appendix C Connector Interconnect 
 

10/16/02Added MSG 

Message 4
Message 5

Message 1
Message 2
Message 3

5
9
7
10
8

NOTE 6

Entertainment  Output
connected to 
audio panel or intercom

Antenna Input
Antenna Ground

2
B

Notes:

AUX Entertainment Input (R)
AUX Entertainment Input (L)
AUX Entertainment Lo

16
17
K

22 Aircraft Ground

Summed Audio Output Hi
Summed Audio Output Lo

18
V

Unswitched Audio Input 4 Hi
Unswitched Audio Input 4 Lo

Unswitched Audio Input 3 Hi
Unswitched Audio Input 3 Lo

Unswitched Audio Input 2 Hi
Unswitched Audio Input 2 Lo

Unswitched Audio Input 1 Hi
Unswitched Audio Input 1 Lo

12
N

13
P

14
R

15
S

Shield GroundZ

28 V Dimmer
14 V Dimmer

A
1

21

C
3
6

A
REV

DATE: SHEET     OF   

TITLE:

DWN

CKD

APR

DATE

DATE

DATE

14- 28 VDC Aircraft Power (2 A Breaker)

AUX Enable

IFE Audio Out (R)
Audio Lo

PXE7300 Connector

REV Change DATE By APR

1.  All audio wiring must be MIL 22750 or 27500
     24 AWG minumum.. 
2.  Power and Ground #18AWG Mil-Spec Tefzel minimum.
     Lighting #22 AWG minimum.
3. Circuit breaker must be PULL TYPE
4. Unswitched audio presented to inputs 1 thru 4 
    is summed and provided at output pin 18 WRT V.
5.  Applying a ground to Pin 20 will activate the AUX mode.
    allowing audio appearing on pins 16 and 17 
    to pass to the output when the MODE is set for AUX.
6. (OPTION 1 UNITS ONLY) Applying a low (ground) 
    or positive (> 5VDC if configured)
    to these pins will activate a specific track on discs 
    which have been preprogrammed by the user.

20

IFE Audio Out  (L)

NOTE 4

NOTE 5

NOTE 3

11/20/02Corrected

01/06/03Add Opt 1
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 Appendix D- STC information and instructions for continu-
ing airworthiness 

8.1 Instructions for FAA Form 337, PXE7300s 

STC SA02572AT applied, with an FAA-Approved Model List (AML) to a broad range of aircraft makes and models. 
Consult www.ps-engineering.com/STC-AML.shtml for the list.  

 One method of airworthiness approval in other aircraft is through an FAA Form 337, Major Repair and Alteration 
(Airframe, Powerplant, Propeller, or Appliance) In the case of the PXE7300, you may use the following text as a 
guide. 

This unit is installed in accordance with FAA-STC SA02572AT, which specifically references the installa-
tion manual. 

Installed IFE System, PS Engineering PXE7300, part number 1197 (X) in (  location  ) at station  .  In-
stalled per AC43.13-2, Chapter 2, paragraph 23 (Instrument Panel Mounting). Installed per PS Engineering 
Installation Operators Manual p/n 200-971-(XXXX), revision (), dated (  ). 

Interface to existing aircraft radios in accordance with installation manual and in compliance with practices 
listed in AC43.13-2, Chapter 2. All wires are Mil-Spec 22759 or 27500. Connection to aircraft dimmer bus is 
____________________. Power is supplied to the unit through a __A circuit breaker (type and part number), 
and total electrical load does not exceed          % of the electrical system capacity with the PXE7300 added. 

Aircraft equipment list, weights and balance amended. Compass compensation checked. A copy of the opera-
tion instructions, contained in PS Engineering document 200-973-( ), revision ( ), dated ( ), is placed in the 
aircraft records.  All work accomplished listed on Work Order  . 

8.2 Instructions for Continuing Airworthiness, PXE7300s 

Sample ICA Checklist for PS Engineering PXE7300s: 
Section Item Information 
1 Introduction Installation of In-Flight Entertainment system. 
2 Description Installation as described in manufacturer’s installation manual referenced on 

FAA Form 337, including interface with other avionics audio as required. 
3 Controls See installation and operator’s guide referenced on FAA Form 337. 
4 Servicing None Required 
5 Maintenance Instructions On Condition, no special instructions 
6 Troubleshooting In the event of a unit problem, place the unit into “off,”  or pull circuit breaker 

labeled”IFE.”. Follow checkout instructions in the installation manual refer-
enced on the FAA Form 337. For a specific unit fault, contact the manufacturer 
at (865) 988-9800 for special instructions.  

7 Removal and replacement informa-
tion 

Removal: Using a 3/32” Allen-head wrench, carefully unscrew the locking 
screw located in the center of the unit. While turning the wrench CCW, gently 
pull on the EDGES of the bezel until the unit is free from the mounting tray. 
Installation: Engage the locking screw at the back. Turn the locking screw CW, 
while applying slight pressure to the edges of the bezel. Do not over tighten!  

8 Diagrams Not applicable 
9 Special Inspection Requirements Not Applicable 
10 Protective Treatments Not Applicable 
11 Structural Data Not Applicable 
12 Special Tools None 
13 Not Applicable Not Applicable 
14 Recommended Overhaul Periods None 
15 Airworthiness Limitations Not Applicable 
16 Revision To be determined by installer 
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8.3 Master Drawing List 

The following drawings are contained on the FAA-Approved Master Drawing List: 

 

Title In this manual Part Number Revision Date 
Installation Manual X 200-973-0002 2 Sept 2002 
Installation Wiring X 120-973-0000 New 20-Nov-02 
Tray Installation Drawing X 120-973-0430 1 16-Sep-02 
PXE7300 Installation Diagram X 120-973-2488 1 16-Sep-02 
PXE7300 Panel Location X 120-973-8801 New 28-Aug-02 
PXE7300 Breaker Location X 120-973-8802 New 28-Aug-02 
Users Guide  202-730-0001 New Sept-2002 
 

8.4 Use of Approved Model List 

STC SA02572AT can be used as a basis for approval in those airplanes listed in the Approved Model List 
(AML, Document Number 002-730-1080) provided the generic installation manual, Document Number 
200-973-0002 or later approved revision, is followed.  

Advisory Circulars AC43.13-1B Acceptable Methods, Techniques, and Practices - Aircraft Inspection and 
Repair, and 43.13-2A - Acceptable Methods, Techniques, And Practices - Aircraft Alterations are to be 
used to resolve any issues not specifically addressed by the Installation Manual. Instructions for Continu-
ing Airworthiness (ICA) are provided in the supplied data. 
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 Appendix E RTCA DO160D/EUROCAE ED-14D Environmental 
Qualification Form  

Part Number: 1197( )  

Manufacturer: PS Engineering Incorporated  9800 Martel Road Lenoir City TN 37772  

Conditions Section Conducted Tests 
Temperature and Altitude 
Low Temperature 
High Temperature 
In-flight Loss of Cooling 
Altitude 
Decompression 
Overpressure 

4.0 
4.5.1 
4.5.2 
4.5.4 
4.6.1 
4.6.2 
4.6.3 

Equipment tested to CAT B1 
-55° C Storage, -20°C Low Operating 
+85°C Storage, +70°C High Operating 
Not Applicable, no cooling required 
25,000’ unpressurized 
Not Applicable 
Not Applicable 

Temperature variation 5.2 Equipment tested to Category C 
Humidity 6.0 Equipment tested to Category A 
Shock 7.0 Equipment tested to Operational test only 
Operational 7.2 
Crash Safety 7.3 Equipment tested Category B 

Vibration 8.0 Equipment tested to Category S 
Explosion 9.0 Category X, not tested 
Waterproofness 10.0 Category X, not tested 
Fluids Susceptibility 11.0 Category X, not tested 
Sand and Dust 12.0 Category X, not tested 
Fungus 13.0 Category X, not tested 
Salt Spray 14.0 Category X, not tested 
Magnetic Effect 15.0 Equipment tested to Category Z 
Power input 16.0 Equipment tested to Category B 
Voltage Spike 17.0 Equipment tested to Category B 
Audio Frequency Susceptibil-
ity 

18.0 Equipment tested to Category B 

Induced Frequency Suscepti-
bility 

19.0 Equipment tested to Category A 

Radio Frequency Susceptibil-
ity 

20.0 Equipment tested to Category U 

Radio Frequency Emission 21.0 Equipment tested to Category H 
Lightning Induced Transient  
Susceptibility 

22.0 Category X not tested 

Lightning Direct Effects 23.0 Category X not tested 
Icing 24.0 Category X, not tested 
Electrostatic Discharge 25.0 Category X, not tested 
Other Tests  Passed FM Emissions testing in accordance 

with CFR 47, Part 15.109. 

 


